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Formatting Text

Introduction

In FrameMaker, the appearance of text is controlled by applying formats. This pro-
cess is also known as tagging text. There are two types of text formats in Frame-
Maker; paragraph formats and character formats. Paragraph formats affect whole
paragraphs, meaning any block or line of text that is terminated with a carriage
return (Y). Character formats are applied to smaller blocks of text within para-
graphs, for example, individual words, phrases, titles, or the like, or to text lines
created with the text tool on the Tools Palette (see Chapter 12). FrameMaker stores
both types of formats in catalogs, which can be accessed via the paragraph format
(1) and character format (f) buttons on the right border of the document window,
as well as by other methods to be described in this chapter.

Every FrameMaker document has some formats in its catalogs, even an empty docu-
ment that you have just created using the New command on the File menu. Docu-
ments that are based on FrameMaker templates inherit format catalogs from their
templates, and even custom documents begin life with a modest selection of paragraph
and character formats. You can build up the catalog for a document by creating for-
mats one by one, as the need arises, or you can import complete catalogs of paragraph
and character formats from another document, as described later in this chapter.

Formats make it easy to achieve a consistent appearance throughout a complex
document or family of documents. By grouping together different characteristics,
such as typeface, point size, line spacing, alignment, word spacing, and many more,
paragraph formats allow you to determine all the essential properties of a para-
graph or group of paragraphs with the single action of applying the appropriate
paragraph tag. There’s no chance of making an error or forgetting one of your
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paragraph’s properties (did I set that last paragraph 10 on 12 or 10 on 11°... and
was the letter spacing loose or normal?); all paragraphs tagged with the same for-
mat will have the same properties. And if you decide later to change the format, all
the tagged paragraphs can be updated with a single action.

Paragraph Formats

After the design of the basic page layouts, as embodied in the document’s master
pages, the most important elements of the design will be found in the paragraph for-
mats (what traditional publication designers and typesetters would call the type
specs). In FrameMaker, any line or block of text that is terminated with a carriage
return is considered a paragraph. Paragraph formats control such text properties as
the default font, line spacing, word spacing, alignment, indentation, tab stops, space
between paragraphs, and many others that will be described in detail in this chapter.

Applying Paragraph Formats

Applying a format to a paragraph is simple:

1. Open the Paragraph Format Catalog by clicking the { button, pressing
Ctrl+1, or selecting Paragraphs>Catalog from the Format menu.

2. Place the insertion point anywhere in the paragraph you want to format by
clicking in it with the mouse. If you want to apply the same format to several
successive paragraphs, drag with the mouse or click in the first paragraph,
then press and hold Shift and click in the last paragraph. (Unfortunately,
there is no way to select nonconsecutive paragraphs in FrameMaker.)

3. Click on the name of the format you want to apply in the catalog. The text in
the selected paragraph (s) will change as required by the new format and the
name of the new format tag will appear in the status area at the lower-left
corner of the document window.

In addition to the Paragraph Format Catalog, you can also select paragraph for-
mats from the pop-up menu on the Formatting Bar, or from the submenu under
the Format menu. Except for opening the catalog window, this process works
exactly as described previously.

¢ For users who prefer command-line style operations to mousing

around on the screen, there is an alternate method for applying para-
graph formats:

SHORTCUT
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1. Place the insertion point in a paragraph or select a group of paragraphs, as
described previously.

2. Press F9; a 1 will appear in the tag area at the lower left corner of the Docu-
ment Window.

3. Begin typing the name of the tag you want to apply. You probably won'’t
need to type the full name, just enough letters to identify the unique format
name. When you have done so, the full name will appear in the tag area.

4. Press Enter to apply the format.
You can also apply a paragraph format from within the Paragraph Designer:

1. Click an insertion point in the paragraph, or select a group of contiguous
paragraphs.

2. Select the desired format from the pop-up menu at the upper-left corner of
the designer.

3. Click the Apply button.

Designing Paragraph Formats

Although applying paragraph formats is simple and quick, designing effective for-
mats takes time and knowledge—knowledge both of how FrameMaker works and
of the craft of typography.

Before undertaking a new project, it’s good practice to make a list of all the possi-
ble paragraph formats your project will require. If you are working on a novel or a
book of short stories, for example, the number of formats you need will be mod-
est—body text, chapter titles, headers or footers, front matter, and perhaps a few
others. If, on the other hand, you are designing a scientific textbook or a technical
manual or journal, you many require dozens of formats: several levels of headings,
bulleted and numbered lists, footnotes, tables, figure, table, and photo captions,
quotes and extracted material... the list could go on and on. Magazines, newslet-
ters, brochures, catalogs—each type of publication will require a particular set of
paragraph formats. The job of the designer is to choose a format for each element
so that they work together as a coherent, logical whole and convey a visual message
that is consistent with the editorial content of the publication.

The Paragraph Designer

You create or edit paragraph formats in the Paragraph Designer (Figure 5.1). (The
Paragraph Designer was called the Paragraph Format Window in previous versions

e e
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of FrameMaker. This window has not just been renamed, but has been significantly
redesigned and has several new features, as will be explained shortly.) To open the
designer, open the Format menu and select Paragraphs, then select Designer from
the submenu (or use the keyboard shortcut Ctrl+M). If a block of text is currently
selected, or if there is an insertion point in a paragraph, the designer will display
the format for that block or paragraph. If the selection includes two or more para-
graphs with different formats, many of the settings in the window will be blank or
set to “As Is.” You can leave the designer open and move to different locations in
the document, and the settings in the designer will change to reflect the current
location of the insertion point.

Figure 5.1

Paragraph Tag‘..
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Properties:
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There is more to the Paragraph Designer than initially meets the eye. The designer
has six different groups of related paragraph characteristics, which FrameMaker
terms properties. You access these groups via the Properties list box, in the left-hand
column of the designer. Opening this box reveals a list of the six groups: Basic,
Default Font, Pagination, Numbering, Advanced, and Table Cell. (Pagination is a
new addition in FrameMaker 4.0. The Tabs group that existed in previous versions
has been eliminated and its functions incorporated in the Basic group.) Every para-
graph will need settings for Basic and Default Font properties. The Advanced prop-
erties, which control hyphenation and word spacing, among other factors, are
important for achieving legible, professional-looking text. The Pagination proper-
ties are mainly concerned with the formats of Side Heads and Run-In Heads, new
features of FrameMaker 4.0. Numbering properties are used only in paragraphs
with automatic numbering. Table Cell properties are used only for tables, and
hence will be discussed in detail in Chapter 20.

Applying and Storing New or Modified Formats

Below the Paragraph Tags and Properties list boxes on the left side of the Para-
graph Designer are the controls you use to apply or store new or modified para-
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graph formats: the Apply button, the Update All button, and the Command pop-up
menu. These controls remain in view whenever the designer is open, whereas the
rest of the designer changes when you select different properties groups.

This section of the Paragraph Designer and the corresponding section

of the Character Designer differ significantly from the comparable sec-

tions in FrameMaker 3.0. Although I cannot really agree that Frame

has managed to simplify the operations performed by these controls,

N 0 T E they have, at least, reduced the danger of accidentally updating all
paragraphs or storing a format in the catalog when all you want to do
is apply a modified format to a selection.

The processes of editing a group and of applying it to a selection or storing it in the
catalog are distinct; you can make as many changes as you like in a property group,
but no changes will occur in your document until you apply it. Applying the group
changes the selection, but does not affect the formats in the catalog. Storing the
edited group in the catalog is a separate operation, involving one of the options on
the Commands menu. There are many options for applying or storing formats
(perhaps too many—the wealth of options can be a bit confusing). Among the
things you can do with an edited properties group are the following:

B Apply it to selected paragraphs.
®  Apply it to all of the paragraphs with a particular format tag.

B Apply it to all paragraphs with tags that are included in the selection and
update the corresponding formats in the catalog.

W Store it in the format catalog under a new or existing format name.

W Apply it to all of the paragraphs in the current document and replace all
of the formats currently in the catalog.

Applying the Properties from a Group to a Selection

For safety’s sake, it is always a good idea to apply a new or modified format to one
or more selected paragraphs to be sure it works satisfactorily before applying it to
all of the paragraphs with a particular tag or storing it in the catalog. Use the fol-
lowing procedure:

1. Click an insertion point in a paragraph, or select a group of consecutive
paragraphs.
Make whatever changes you want in the properties group.

3. Click the Apply button.

R
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It is important to perform the steps in the order specified above. If you
click an insertion point in a new paragraph after editing the properties,
the properties will revert to those of the selected paragraph.

~
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If, after editing one group of properties, you select a different group of
properties without first applying your changes, a dialog box like that in
Figure 5.2 will appear, asking whether you want to apply your changes
from the first group of properties before going to the second group,
and offering you the choices of Apply Changes, Update All, Don’t
Apply, or Cancel (return to the first group of properties). Use Apply
Changes to apply the properties to the selected paragraph(s). Use
Update All to apply the changes to all the paragraphs with the speci-
fied tag. If you choose Don’t Apply, the changes you made in the first
group of properties will be lost.

~
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Figure 5.2 Apply Changes prompt box

T ————————————————
Apply Changes
Basic properties have been changed.
Before displaying Default Font properties:

To Selection

Fomnats Tagged: Body

Updating All Paragraphs with a Given Tag
Use this procedure to change the format of all the paragraphs in a document with
a particular format tag and store the edited format in the catalog.
1. Click an insertion point in a paragraph with the tag you wish to update.
Make whatever changes you want in the properties group.

3. Confirm that the correct tag name appears below the Update All button,
then click the button to execute the update.

4. If some of the tagged paragraphs contain format overrides, a dialog box will
appear to warn you of that fact, and offer you the options of retaining or
removing the overrides or canceling the operation

S
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Format Overrides are modifications to the paragraph format that have

made via the Formatting Bar, via the text editing buttons on the Quick

not been stored in the catalog. They may be the result of changes
‘

Access Bar, by applying a Character Format (described later in this

T E chapter) or by applying an edited group of properties but not saving it

in the catalog. Paragraphs with format overrides are identified by an
asterisk (*) in front of the tag name in the status bar and on the For-
matting Bar.

Replacing All Occurrences of One Tag with a Different Tag

1.

Click an insertion point in a paragraph with the tag with which you wish to
replace another tag.

Make whatever changes you want in the properties group.
Open the Command pop-up menu and select Global Update Options.

In the dialog box, select the All Tagged radio button. Open the pop-up
menu next to the radio button and select the name of the tag you want to
replace.

Click the Update button to perform the operation. (This command does
not affect the formats stored in the catalog.)

Applying Properties to All Tags that Match Those in the Selection

1.

Select two or more consecutive paragraphs with the formats you wish to
modify. Keep in mind that this operation will modify all paragraphs anywhere
in the document that have the same tags as those you selected, not just the
selected paragraphs.

Make whatever changes you want in the properties group.
Open the Command pop-up menu and select Global Update Options.

In the dialog box that appears (Figure 5.3), select the All Matching Tags in
Selection radio button. You can choose to update the specified paragraphs
either with just the properties in the currently displayed group, or with all
the properties of the selected format.

-




82mPower of..FrameMaker 4.0

Figure 5.3 Global Update Options dialog box
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5. Click the Update button to apply the format. This operation modifies not
just the paragraphs in the document with the selected tags, but also those
tags in the format catalog.

Storing a2 New Format in the Catalog

1. Make whatever changes you want in the properties group.
2. Select New Format from the pop-up Command menu.

3. A dialog box like that in Figure 5.4 will appear. Type the name for the new
format in the text box and check the Store in Catalog check box. (If you
want to apply the new format to the selection at the same time, check that
check box also.)

Figure 5.4 New Format dialog box

New | ormat

Create a new patagraph format using
the properties in the Paragraph Designer.

Tag: Head A ]

Store in Catalog X Apply to Selection

Click Create to store the new format in the catalog.

An alternate way to store a new format is to type a new format name in the
text box at the upper left corner of the designer, then click Apply. The dia-
log box in Figure 5.4 will appear. Proceed as described previously in steps 3
and 4.
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Updating an Existing Format

1.

2
3.
4

Place the insertion point in a paragraph with the format you wish to modify.
Make whatever changes you want in the properties group.
Open the Command pop-up menu and select Global Update Options.

In the dialog box that appears (Figure 5.3), select the All Tagged: radio but-
ton. Check to be sure the format name in the text box next to the radio but-
ton is the one you want to modify. You can choose to update the format
either with just the properties in the currently displayed group, or with all
the properties of the selected format.

Click the Update button to apply the format. This operation will update all
the paragraphs in the document with the specified tag and will also update
that format in the catalog.

Applying a Format to A// Paragraphs in a Document
and A/l Entries in the Format Catalog

1
2
3.
4

Place the insertion point in a paragraph with the format you wish to apply.
Edit the properties if necessary.
Open the Command pop-up menu and select Global Update Options.

In the dialog box that appears (Figure 5.3), select the All Paragraphs and
Catalog Entries radio button. You can choose to update the paragraphs
either with just the properties in the currently displayed group, or with all
the properties of the selected format.

Click the Update button to apply the format.

This operation cannot be undone. A dialog box will appear and offer you
three options: select Yes to update all paragraphs and catalog entries. Select
No to update the formatting of all paragraphs without changing their tag
names. Select Cancel to return to the designer without updating the para-
graphs or catalog.

Deleting a Format from the Catalog

Select Delete Format from the pop-up Command menu.

Select the format you wish to delete from the list box in the dialog box that
appears.

Click the Delete button to delete the format.
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When you delete a format from the catalog, paragraphs already tagged

with that format do not change. The format name simply disappears

from the catalog window and from other menus where it would nor-

mally appear. You can restore a deleted format to the catalog by select-

N 0 T E ing an existing paragraph with the format and storing the format to
the catalog as a new format, or by copying the format from another
document.

Restoring the Designer to its Previous Condition

If you have made some changes to a properties group but have not yet applied
them to a paragraph, you can restore the properties to those of the selected para-
graph by opening the Command menu and selecting the Reset Window From
Selection command. If you have edited a group of properties and applied it to a
paragraph with unsatisfactory results, you can easily restore the paragraph to its
previous state, provided you have at least one unmodified paragraph of the type
you are working on. (This is one reason you should make a habit of testing a new
format on a single paragraph before applying it to all of the formats with the same
tag or storing it in the catalog.)

1. Click an insertion point in an unmodified paragraph of the appropriate
type.
Open the Edit menu and select Copy Special>Paragraph Format.

Click an insertion point in the paragraph you want to restore.

4. Open the Edit menu and select Paste or press Ctrl+V.

This method can also be used to copy a format between documents.

NOTE

Modifying a Few Paragraph Properties While Leaving the Rest Unchanged

Occasionally, you might want to modify only one or two properties of a group of
paragraphs with different formats, while leaving all the other properties as they are.
For example, you might want to change the font family of your body paragraphs
and related items, such as bulleted and numbered lists, extracts, and figure cap-
tions, from Times Roman to Adobe Caslon, leaving all the other paragraph proper-
ties unchanged. To do this, set the options in the designer to As Is by selecting Set
Window to As Is from the Command pop-up menu. This will reset all the properties
groups to As Is; optional settings will be blank, settings which must have a value will
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display As Is, and check boxes will be shaded gray. Now you can edit the Font Fam-
ily setting in the Default Font group and apply only this property to the paragraphs
you choose. Unfortunately, there is no really simple way to apply such a format
change to a large group of paragraphs with different tags. If examples of all the dif-
ferent formats exist in one contiguous block that doesn’t include any paragraph
formats you don’t want changed, the process is simple: just use the All Matching
Tags in Selection settings in the Global Updates dialog box. Otherwise, you may
have to repeat the process for several different groups.

Basic Paragraph Properties

The Basic Properties group (Figure 5.5) is concerned with indents, alignment, line
spacing, and tabs. These settings are, for the most part, simple and straightforward.

Figure 5.5 The Basic Properties Group in the Paragraph Designer

"Paragraph Des
Paragraph Tag‘. Space: Tab Stops:
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Properties: Eﬂ.ll Pt
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To Selection
(——
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Indents

There are three types of indents you can set: First, Left, and Right. Except in the
special case of side heads (in the Pagination group, described later), all three are
relative to the borders of the text column. The values for these three settings are
displayed in the unit selected in the View Options dialog box (see Chapter 2), but
remember, you can type new values in whatever units you prefer and FrameMaker
will perform the conversion if required.

The indent settings in FrameMaker differ slightly from some other desktop pub-
lishing applications with which you may be familiar, in that the first line indent is
relative to the column edge, rather than to the left indent. Hence, to produce a
hanging indent in FrameMaker, you would use a positive left indent and a zero
first-line indent, rather than a negative first-line indent. For example, to set a one
pica hanging indent, specify a first indent of 0 and a left indent of 1pica.

You can also change the indents for the current or selected paragraph(s) by drag-
ging the arrowheads that appear on the top ruler in the document window. (You

R
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can do this whether or not the Paragraph Designer is open.) The upper black
arrowhead on the left is the first indent, the lower one is the left indent, and the
hollow arrowhead on the right is the right indent. If the Snap Grid option in the
View Options dialog box is checked, you will only be able to drag the arrowheads to
locations that match the ruler ticks. Changes made this way take effect immediately,
without your having to select the Apply button if the dialog box is open. You can
apply a set of indents created this way to other tagged paragraphs or save it in the
catalog via the Global Update feature.

Space

There are two settings for this parameter: Above and Below. These settings control
the vertical space between paragraphs. The space between consecutive paragraphs
is always the larger of the space below the first paragraph and the space above the
second. For example, if the first paragraph has a space below of 6 points and the
second paragraph has a space above setting of 12 points, the space between para-
graphs will be 12 points. The Above setting is not used when a paragraph occurs at
the top of a page or column.

Line Spacing

This property replaces the one called Leading in FrameMaker 3.0. By default,
FrameMaker uses a line spacing that is 120% of the default font height. You can
specify a different line spacing in points by typing a new value in the box, or you
can select multiples of 1.5 times or double the specified line spacing from the drop-
down list box.

If the Fixed check box is checked, the line spacing will not change if there are over-
sized characters in some lines of the paragraph. If the box is not checked, the line
spacing will expand if necessary to accommodate taller characters.

Alignment

There is nothing novel in the alignment options offered by FrameMaker: As Is, Left,
Center, Right, and Justified. As Is means leave the alignment of the paragraphs
unchanged—handy when you’re changing some other aspect of the format of two or
more paragraphs with different alignments. The other options are familiar and self-
explanatory to every desktop publishing or word processing software user.

Tab Stops

Use the Tab Stops section of the Basic Properties to set tab stops in the paragraphs
that require them. All tab stops in FrameMaker have two properties: position (mea-
sured from the left edge of the text column) and alignment. FrameMaker uses the
same four standard types of tab stop alignments found in most word processing
and desktop publishing applications: left, right, center, and decimal. In addition, a
tab can have a leader character (a character that fills the space created by the tab—
used mainly in indices, tables of contents, and other tables). The alignment charac-
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ter for decimal tabs can also be changed; that is, it need not necessarily be a deci-
mal point.

Tab stop positions in FrameMaker are absolute. That is, when you

press the tab key, the nth press of the Tab key moves the insertion point

‘ to the nth tab position. Thus, if the position of the insertion point is

between the third and fourth tab stops in a paragraph, and there are

N 0 T E no other tabs in the line, you will have to press the tab key four times
to move to the fourth tab position.

To edit an existing tab stop or create a new tab stop using the designer, select New
Tab Stop or the position of an existing tab stop form the list box in the designer,
then click Edit. This opens the Edit Tab Stop dialog box (Figure 5.6—you can also
open this dialog box without opening the designer, by double-clicking a tab stop on
the top ruler). The current position of the selected tab stop is shown at the top of
the dialog box (if you selected New Tab Stop, this space will be blank). Below the
current position is a box labeled New Position. Type a value here if you are creating
a new tab stop or changing the position of an existing tab stop. Both the current
position and new position are expressed in the display units you selected for the
document, but don’t forget you can type a value in any of the units supported by
FrameMaker and the program will translate as necessary.

In addition to setting the position of the tab, you can also select the alignment
(Left, Center, Right, or Decimal) with the radio buttons on the left side of the dia-
log box. If you select a Decimal tab, you must type an alignment character in the
Align On box. A decimal point (.) will be appropriate for most uses, but you could
use a comma if you are working with European currencies. Use the buttons on the
right side of the dialog box to select a leader character. You can select among
FrameMaker’s predefined leaders or select Custom and type one or more charac-
ters in the adjacent text box. Some of the more obvious possibilities are the em
dash (type \m in the box), the asterisk, or the underscore. Although it is not obvi-
ous why you would want to do so, you can use a different leader character for each
of the tab stops in a paragraph.

It is now easy to create a series of evenly spaced tab stops in FrameMaker. Just check
the Create Every check box and type a spacing value in the adjacent text box.
Before you do this, you will probably want to clear any existing tab stops from the
paragraph by selecting the Delete All button at the bottom of the dialog box. You
can also delete the single selected tab stop by selecting the Delete button.

To save the new tab stops you have created, exit the dialog box by selecting Con-
tinue. To abandon your changes, select Cancel. As with all the properties in the
Paragraph Designer, you must apply your edited tab stops to see their effect.

s
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Figure 5.6 The Edit Tab Stops dialog box
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After you apply an edited tab stop, the selection in the Tab Stops list
box will always change to New Tab Stop. If you fail to notice this, you
‘ may waste some time opening and closing the Edit Tab Stop dialog
box when you want to re-edit the same tab stop.
NOTE

You can also use the ruler and Formatting Bar in conjunction with the designer.
You can drag tab stops to new locations, delete tab stops by dragging them off the
ruler, or add new tab stops using the buttons on the Formatting Bar. Whatever
changes you make will be reflected in the Tab Stops list box in the designer, and
can be stored or applied using the various Update and Apply options described ear-
lier in the chapter.

If Snap is on when you drag tabs to new positions, you will be able to
position the tab stops only at ruler ticks. However, when you type tab
positions in the Edit Tab Stop dialog box, you can place tab stops any-
where, regardless of the Snap setting.

FrameMaker’s sophisticated table editor, described in Chapter 20,
largely eliminates the need for complex tab settings.
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Next 7 Tag

Normally, when typing text in FrameMaker, when you press the Enter key to end a
paragraph, the next paragraph will automatically inherit the format of the preced-
ing paragraph. In some cases, this is convenient—for example, when typing consec-
utive paragraphs of body text. In other cases, it isn’t—for example, a particular type
of heading or subheading will virtually never be followed by another heading or
subheading of the same kind. The Next { Tag option allows you to specify a differ-
ent paragraph type to be started when you press Enter at the end of the specified
paragraph. For example, you might choose to make the paragraph after a heading
or subheading a body paragraph.

The Next ] Tag setting has no effect when tagging previously typed or
imported text. It works only when you type new text.
‘

NOTE

Default Font Properties

The next group in the Paragraph Designer selects the Default Font for the para-
graph (see Figure 5.7). This font will be used for all text in the paragraph unless it
is overridden by a character format (described later in this chapter).

Figure 5.7 The Default Font Properties group in the Paragraph Designer
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All the controls in the Default Font group are duplicated in the Char-
acter Designer (described later in this chapter) and can be applied to
‘ individual characters, words, and phrases via Character Formats.
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Font Family

The Font Family menu displays all the font families you have currently installed
under Windows. This includes both type 1 PostScript fonts installed via Adobe Type
Manager and TrueType fonts supplied with Windows or installed from the Windows
Control Panel if both of these options are active.

If you are producing final output on an in-house laser printer, its okay to
freely mix TrueType and PostScript Type 1 fonts as you choose. However,
if you’re sending files to a service bureau for final output, you may need
to limit yourself to Type 1 fonts, since most imagesetters have only Post-

WARNING  Script rasterizers. To save yourself some grief, consult your service bureau
at the beginning of the design process on what fonts they support.

Size

Use this box to specify the font size in points. You can either open a pop-up menu
and select from a list of the most common sizes or type a value between 2 and 400
in the box (fractional point sizes are supported). (See Chapter 6 for an explanation
of point sizes and other typographic measurements.)

Below the Size box are three list boxes from which you select variations within the
selected font family: Angle, Weight, and Variation. The options you see in these
boxes will depend on the font family you have selected. Angle is usually limited to
two choices, Regular and Italic, or Regular and Oblique. Italic and Oblique both
mean the same thing in this context: type that slants to the right. The term italic
seems to be used more often in reference to serif typefaces whereas oblique is used
more frequently in reference to sans serif typefaces. However, there is no unifor-
mity in this matter; the choice of the term seems to be at the whim of the type
designer or vendor. Backslanted (left-leaning) type exists, but is extremely uncom-
mon. Some decorative or display typefaces will have only a single (regular) slant.

Weight

Weight specifies variation in the thickness of the letter forms, the most common
being regular (or medium) and bold. Some font families, however, include a
greater variety of weights, including light, regular, demi- or semi-bold, bold, and
extra-bold or black. As with slant, there are a variety of different terms for describ-
ing type weights and little uniformity in their use.

Variation

This option might more appropriately be called width, as it deals with type varia-
tions such as narrow, condensed, regular, semi-extended, and extended. Because of
the way Windows groups type into families, in most cases you won’t find any varia-
tions here except Regular and As Is. For example, if you have Helvetica, Helvetica
Narrow, Helvetica Condensed, and Helvetica Extended installed on your system,
these four typefaces would appear as four different families on the Font Family
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menu, rather than as a single family called Helvetica with four different width vari-
ations.

Color

Use this option to select one of eight predefined spot colors, or any new colors you
have defined, from a pop-up menu. Obviously, this option is useful only if you are
designing a document for a multicolor print job.

Spread

The final option in the Default Font Properties group is an important one,
although it might escape your notice, hiding here under an obscure and unreveal-
ing name. Spread controls what traditional typesetters call letter spacing (the spac-
ing between characters within a word) as distinct from word spacing (the spacing
between words). Letter spacing differs from pair kerning (another Default Font
property, described later in this section) in that it affects all characters in a word,
not just selected pairs. Some other Windows desktop publishing applications use
the term tracking to designate this property.

The method FrameMaker uses to describe the amount of letter spacing is also
unconventional. Normally, letter spacing is specified by general terms such as very
loose, loose, normal, tight, and very tight, or more precisely, as fractions of an em to
be added or subtracted. FrameMaker specifies letter spacing as a percentage, with
zero percent representing normal (no space added or subtracted between charac-
ters). A positive value represents looser spacing; a negative value represents tighter
spacing. Figure 5.8 shows a paragraph set with several different letter spacings.

Attribute Settings

On the right side of the Default Font group are seven check boxes for selecting
additional variations on the default font: Underline, Overline, Strikethrough,
Change Bar, Superscript/Subscript, Capitalization, and Pair Kern. These options,
previously grouped together under the heading of Style, have undergone some
additions and modifications in FrameMaker 4.0. Most of these options are straight-
forward, and are familiar to experienced Windows word processing and desktop
publishing software users. Their effects are shown in Figure 5.9.

Some of these options are more appropriately applied in Character
Formats. (Can you think of a situation in which you would want to seta
‘ whole paragraph of superscript, subscript, or overline?)

NOTE

Underline has been changed from previous FrameMaker versions and now offers
three choices via a drop-down list box: Underline (single), Double Underline, and
Numeric Underline. Numeric Underline differs from normal underline in that the
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offset and thickness of the line is constant. With the normal underline, the thick-
ness of the line will vary with the size and weight of the underlined type. The thick-
ness and offset of the Double Underline are also fixed.

Figure 5.8

Several paragraphs with different letter

spacing (“spread”) settings

Spread -5%

Congress shall make no law respecting an estab-
lishment of religion, or restricting a free exercise
thereof; or abridging the freedom of speech, or of
the press; or the right of the people peaceably to
assemble, and to petition the Government for the
redress of grievances.

Spread -2%

Congress shall make no law respecting an estab-
lishment of religion, or restricting a free exercise
thereof; or abridging the freedom of speech, or of
the press; or the right of the people peaceably to
assemble, and to petition the Government for the
redress of grievances.

Spread -1%

Congress shall make no law respecting an estab-
lishment of religion, or restricting a free exercise
thereof; or abridging the freedom of speech, or of
the press; or the right of the people peaceably to
assemble, and to petition the Government for the
redress of grievances.

L

Spread 0%

Congress shall make no law respecting an
establishment of religion, or restricting a free
exercise thereof; or abridging the freedom of
speech, or of the press; or the right of the
people peaceably to assembie, and to petition
the Government for the redress of grievances.

Spread 1%

Congress shall make no law respecting an
establishment of religion, or restricting a
free exercise thereof; or abridging the free-
dom of speech, or of the press; or the right
of the people peaceably to assemble, and to
petition the Government for the redress of
grievances.

Spread 5%

Congress shall make no law respecting
an establishment of religion, or restrict-
ing a free exercise thereof; or abridging
the freedom of speech, or of the press;
or the right of the people peaceably to
assemble, and to petition the Govern-
ment for the redress of grievances

publishing programs.

.

NOTE

FrameMaker does not provide the controls for customizing the thick-
ness and offset of underlines found in some other Windows desktop

The Change Bars option is specific to FrameMaker and is not really a typeset
option at all. Change Bars are vertical bars that appear in the margin next to text
that has been edited, as in Figure 5.10. This option is particularly useful when sev-
eral people have to work together on a document. Change Bars can be turned on

R
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for specific types of paragraphs via the check box in the Paragraph Designer or an
analogous check box in the Character Designer (described later in this chapter) or
they can be turned on globally for the entire document by selecting the Change
Bars option on the Format menu and checking the Automatic Change Bars box in
the Change Bars dialog box (Figure 5.11). The other settings in the dialog box con-
trol the position and appearance of the bars and allow you to clear all the change
bars in a document.

Figure 5.9 The effects of the attribute settings in the
Default Font group

Underline

Numeric Underline
Double Underline
Overline
Strikethrough

script

Super
Subgeript

SMmaLL Caps

Figure 5.10 A document with change bars
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Figure 5.11 The Change Bars dialog box

Change Bar Properties

Dastance biom Column HIFON

Thickness 20 ","

Position ;,l eft of Column :
Colon ‘m

[} Automatic Change Barg

| Clear All Change Bars

‘

(No Undo)

The settings in the Change Bars dialog box will allow you to position
change bars beyond the margins of your physical page. It may also fail
‘ to display the change bars at some screen magnifications if you make
the bars too thin. If you are going to use change bars, it is up to you to
N O T E select settings that work in your document and on your screen.

Superscript/Subscript, which were two separate check boxes in FrameMaker 3.0,
have been combined into a single drop-down list box. You can now set the offset
and size of superscripted and subscripted characters in the Document Properties
dialog box (select Document from the Format menu). Unfortunately, these settings
are global for the document, which is really not satisfactory. Fine typography
requires that superscript and subscript sizes and positions be selected in relation to
the font in which they are used. Factors such as x-height, cap height, and ascender
and descender heights should be taken into consideration. If you need superscripts
and subscripts in your documents, it is probably best to set the size and offset for
the text format in which you use them most frequently, for example, body text or
figure captions. If these settings are not satisfactory for other text formats, you will
have to shift them manually with the Control and arrow keys.

Capitalization is a new option in FrameMaker 4.0. There are three options in this
drop-down list box: Small Caps, Lowercase, and Uppercase. Lowercase and Upper-
case are straightforward, if not terribly useful: they set all of the text in the selection
to either lowercase or uppercase. The Uppercase setting may occasionally be useful
for headings, i.e., when you want to change a group of headings that were typed
caps/lowercase to all caps.

The Small Caps setting requires some additional explanation. This setting formats
regular caps/lowercase type as full-size caps/reduced caps. The height of the
reduced caps is set, as a percentage of the normal cap height, in the Document Prop-
erties dialog box (Format>Document). This feature might better be called simulated
small caps or reduced caps; the result is not the same as true small capitals.
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The last check box, Pair Kern, adjusts the spacing of certain pairs of characters so
that their bodies overlap. Which pairs of characters are adjusted depends on the
design of the font and is based on kerning tables that are part of the font files.
Some character pairs that are normally kerned are shown in Figure 5.12. Good
kerning is particularly important for large display type. You can also apply pair
kerning to selected pairs of characters via the Character Designer, described later
in this chapter.

Figure 5.12 Kerned vs. unkerned character pairs

1
Not Kerned Kerned
AT AY AVAW Ay AvAw A'FAF.F, TO AT AY AVAW Ay AvAw A’ FAF.F, TO
TATaTeToTiTrTuTyTwTsTe T. T, TATaTeToTiTrTuTyTwTs Tc T. T, T:
T.T;T-LTLYLVLWLy L' PAP.P,VA T,T-LTLYLVIWLyL PAP.P,VAVa
VaVeViVoVrVuVyV.V,V:V;V-RT Ve ViVo VrVuVy V.V, V: V; V- RT RV
RV RW RY Ry ff WA Wa We Wo Wi Wr RW RY Ry ff WA Wa We Wo Wi Wr
WuWyW. W, W: W; W- YA Ya Ye Yo WuWyW. W, W:W; W-YAYaYeYoYi
YiYpYgYuYvY.Y, Y. Y;Yrr,r-y.y, YpYqYuYVY.Y, Y:Y;Y-L.r, -y y, V.
V.V, W. W, V, W. W,

Manual Kerning and Shifting

In addition to using the Pair Kern option in the Default Font Properties group, you
can manually shift the position of selected characters either horizontally or verti-
cally by pressing and holding the Alt key and pressing one of the arrow keys on the
numeric keypad. The increment which the characters are shifted depends on the
screen magnification—the higher the magnification, the finer the movement.
Unfortunately, there is no way to store the shift as part of a format. Hence, if you
want to use the same shift consistently (for example, to do a manual superscript or
subscript), you'll just have to remember how many keystrokes to use.

You can also use the Spread option in the Character Designer to adjust

the horizontal spacing of selected characters.
‘

NOTE

Pagination Properties

The Pagination Properties group (Figure 5.13) is new in FrameMaker 4.0. It com-
bines three options that were parts of other groups in FrameMaker 3.0, Start, Keep
With, and Widow/Orphan Lines, with controls for two types of heads that are new
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in FrameMaker 4.0: Run-In Heads, which appear as part of the first lines of other
paragraphs, and Side Heads, which “hang” in the margin outside of text columns.

Figure 5.13 The Pagination Properties group in the Paragraph Designer

T pagophOsoiner |

Start: Keep With:

’Anvwhele 1 ’Wﬂcﬂ L

Format:

Paragraph Tag:

Properties:
i

& Normal

To Selection

Fialma: Tagged: "
sidehead O Asls

Commands: [} Leave Room for Side Heads in Flow —

Start

This option can be used to restrict the placement of certain types of paragraphs.
The options are As Is, Anywhere, Top of Column, Top of Page, Top of Left Page,
and Top of Right Page. For example, you would probably allow body paragraphs to
start at any location on the page where the text flow happens to put them, but you
might want to restrict the placement of your highest level of heading to the top of
the column or the top of the page. If you want each new chapter of a publication to
start on a right-hand page, you could format your chapter titles or chapter numbers
to start at the top of the right page.

Keep With

This option also affects the placement of paragraphs on the page by allowing you to
force two consecutive paragraphs to stay on the same page or move to the next
page together. The options are Next {, meaning keep the tagged paragraph on the
same page as the following paragraph, and Previous §, meaning keep the tagged
paragraph on the same page as the previous paragraph. For example, you would
not want a subhead to appear at the bottom of a column or page, so you would for-
mat your subheads keep with Next . This way, a subhead that would otherwise
appear at the bottom of a column or page would be forced to the top of the next
column or page in order to stay with the body paragraph to which it refers.

Widow/Orphan Lines

The term widow has two different meanings in typography. Traditionally, it meant
a single word or hyphenated syllable forming the last line of a paragraph. In
FrameMaker and other desktop publishing applications, a widow is the first line
of a new paragraph that occurs at the bottom of a text column, with the remain-
der of the paragraph occurring at the top of the next column or page. An orphan
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is the last line of a paragraph occurring at the top of a text column. The Widow/
Orphan Lines value in the paragraph format specifies the minimum number of
lines from the paragraph that must be kept together at the top or bottom of a
text column. Be aware that, in multiple column formats, a widow/orphan setting
greater than one may make it difficult to achieve even columns at the bottom of
the page. However, you may be able to compensate for this with the Feathering
feature (see Chapter 7).

Run-In Heads

A run-in head is a head that appears as part or all of the first line of a text para-
graph, such as that in Figure 5.14. It is distinguished from the rest of the paragraph
by having a different character format, for example a different type family, weight,
or angle. In FrameMaker 3.0, you could create the appearance of a run-in head by
applying a different character format, but the run-in head remained part of the
text paragraph, and hence could not be included in a table of contents or other
generated list, used as the target of a cross-reference, or mirrored in a header or
footer. Nor was it easy to transform freestanding heads to run-in heads or vice versa.
Either operation required considerable manual editing. FrameMaker 4.0 corrects
this shortcoming.

Figure 5.14 A Run-in head

Article V—The Congress, whenever two thirds
of both houses shall deem it necessary, shall
propose Amendments to this constitution, or,
on application of the Legislatures of two thirds
of the several States, shall call a Convention for
proposing Amendmendments, which, in either
case, shall be valid to all Intents and Purposes
as part of this Constitution, when ratified by the

To transform another paragraph, such as a freestanding head, to a run-in head, click
an insertion point in the paragraph, then select the Run-In Head radio button. You
may optionally specify a space and/or punctuation mark to separate the run-in head
from the rest of the paragraph by typing it in the adjacent text box. If you want to use
a special character, type its symbolic code (for example, \m for an em dash). Apply
the run-in head properties to the selection like any other paragraph properties and
the run-in head will move to the appropriate position in the following paragraph. If
necessary, switch to the Default Font properties group to change the format of the
run-in head to distinguish it from the text paragraph it runs into.
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Side Heads

Side heads are headings that appear to hang in the margins, outside the text col-
umns of a document. Actually the heads are in the text columns, but the columns
have been divided into two areas, one for regular body paragraphs and another for
the heads. Hence, side heads require a bit more planning than most other para-
graph format options (though, of course, you should carefully plan all aspects of a
publication design). You must design the text columns of your document (see
Chapter 4) to allow room for both the regular text area and the heads. This entails
making the text columns wider than normal, extending them into what would nor-
mally be the margins.

Having designed a page layout with text columns of appropriate dimensions, use
the following procedure to create a Side Head format:

1. Place an insertion point in the text flow where you want to use the format.
(Unlike other paragraph format properties, a side head format affects all of
the text in the flow—all paragraphs that are not formatted as side heads are
indented to make room for the heads.)

2. Select the Layout button in the lower-left corner of the designer. The dialog
box in Figure 5.15 will appear.

Figure 5.15 Side Head Layout for Current Flow dialog box

| Side Head Layout for Current Flow |

Side Head Layout for Cusrent Flow

X Leave Room for Side Heads in Flow

width:  [1.333"
Gap:  [0.067"

Check the Leave Room for Side Heads in Flow box.

4. Specify the Width of the side head column and the Gap between the side
head column and the regular text column. The sum of these spaces will be
subtracted from the text column.

5. Select the position of the side heads from the pull-down list box. The
options are Left, Right, Inside, and Outside (see Figure 5.16).
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6. Select Set to apply the format to the flow. Any text paragraphs not tagged as
side heads will move out of the area reserved for the heads.

Having prepared the columns for the heads, you can design the heads themselves:

1. Click an insertion point in a paragraph that you want to format as a side
head.

2. Select the Side Head radio button.

3. Select one of the three alignment options: First Baseline, Top Edge, or Last
Baseline. First Baseline aligns the first baseline of the body paragraph with
the first baseline of the side head. Top Edge aligns the top edge of the first
line of the body paragraph with the top edge of the first line of the side
head. Last Baseline aligns the baseline of the first line of the body para-
graph with the baseline of the last line of the side head. (For side heads with
a single line, there is no difference between First Baseline and Last Baseline
alignment.)

4. Apply the format to your selection and/or store it in the catalog.

5. Create whatever other properties your side heads require (for example, font
family, weight, alignment, and so on), as you would for any other paragraph.

When you use a side head format, all indents and tab stops in non-side

head paragraphs are measured from the edge of the normal text area,
‘ rather than from the edge of the larger text column.
NOTE

When you change the vertical alignment of side heads, the heads

remain stationary and the body paragraphs are shifted up or down to

‘ make the alignment. Hence, choosing Last Baseline for multi-line side

heads can result in significant extra space being inserted between body
paragraphs.

0T

Positioning Heads Across the Full Page Width

There is one other head-formatting option in the Pagination Properties group, rep-
resented by the Across Side Head and Normal Areas radio button. Applying this
option causes a head to occupy both the side-head column and the regular text col-
umn. You could use this setting for major, top-of-page headings or chapter titles in
a publication that uses side heads for minor headings. Or you could use it in con-
junction with various left indents to create staggered headings that begin in the

TR
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margin and overlap the body text columns (Figure 5.17), a popular format in tech-
nical books and manuals at present.

Figure 5.17 Staggered headings (created with the
“Across Side Head and Normal Areas” option)

Across full page width______ | Here's an A-Head—Full Page Width

frame. you must elick sn insertion point in text at the location where you
want to anchor Lhe frame. Afier you place the insertion point, sclect the
Anchored Frame command (keyboard shorcut Esc 3 a) This opens he
Anchored Frame dialog box (Figure XX.7) This dialog box is used bouo
reate new frames and edit existing ones. Use the controls in this dialog box.
10 specify the poution and size of the frume The cight radio buttons for
selecting the pasition of

the frame are divided mto three groups, s ndicated by the borders within
he dialog box. Use one of he bultons 1 the top group 10 place the frame i
the text column thas consains the anchor. Use the kooe bulton in the muddlc
70 0 place the graphic dnecty ot the anchor poin i the text line. Use:
‘one of he bultons 1n the lower grop 1o place the frame in the margin, (The
functions of cach o the groups will be cxplsined in deal n th following
section.) Use the Widith and Height text boxes tospecify the sizof the frame

Across full page width This Is a B-Head

with ’eﬂ indent frame, you must ciick an taertion pownt m text at the location where you
o e . s
Anchored Frame command (keyboard shortcut Exc s opess he
‘Anchored Frame dialog bax (Figure XX.?) This dualog box 18 used both o
e et i e et
o o e e o
et o
Normal This is a C-Head

he frame are divide] 110 three groups. s odicaicd by the borders within
the dialog bos. Use one of e buttons inthe 1op g7oup 10 place the frume n
the teat colume tha contains he anchor. Use th lose buion un the middle
Froup 1 place the graphi dirccly a the anchor point i the tex! ine. Use:
one o the buitons i the Jower g10up © place the frame i the margim. The
fonctions of each of the groups will be explained m detal in the followng

Numbering Properties

The fourth group in the Paragraph Designer is used to create autonumbered para-
graphs. Autonumbering is a powerful feature of FrameMaker that allows you to cre-
ate numbered series of paragraphs, such as steps in a process, series of equations,
numbered headings, figure and table captions, or topics in an outline. When you
add or delete items in an autonumbered series, FrameMaker automatically adjusts
the numbering.

The principal action to be performed in the Numbering Properties group (see Fig-
ure 5.18) is the design of the autonumbering format for the selected paragraph
type. An autonumbering format can include the following items (see Figure 5.19):
A series label, one or more counters, text and punctuation (which can occur both
before and after the counter), and special characters such as bullets or tabs. If you
want the numbering to use a different typestyle than the default for the paragraph,
you can include a character format.

To create a numbering format, turn autonumbering on by checking the check box.
Next, select a counter from the building blocks displayed in the list box. You can
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type the building blocks in the text box below the autonumbering check box, or
you can add building blocks to the format by clicking on them in the list box. The
principal building blocks are described in Table 5.1.

Figure 5.18 The Numbering Properties group in the Paragraph Designer

" Paragraph Designer
< Autonumber foimat:
Akn=1>.<n*>
Building Blocks:

Character Format:
|Emphasit
'Defauit 1 Font
| BulietSgmbol
{Callout

i ChapterNumber

To Selection
I:

Foimats Tagged:
Body

Commands: i

Pasition:

I Statt of Paragiaph ‘i

Figure 5.19 Anatomy of a numbering format

X] Autonumber Format:
Ib.:'ttFigum <n>.<n+> —|

, I
Series Label TabText Counters

Table 5.1 Numbering format building blocks
Code Meaning Example
n Arabic numeral 1,2,3,...
a lowercase alphabet a,b,c,...
A uppercase alphabet ABC, ...
r lowercase Roman numeral i, 1, iii, ...
R uppercase Roman numeral LIL 111, ...

The counter portion of the format is placed between angle brackets (<>). Other items,
such as text, punctuation, or tabs, are placed outside the brackets. The additional sym-
bols + and = are used inside the brackets to control how the numbering is updated: +
means update the counter by 1, and = means set the counter to the value that follows
the = sign. For example, <n+> means use Arabic numerals and update the counter for
each paragraph with the tag; <n=1> means use the number 1 for each paragraph
with the tag. A numbering symbol without a + or = sign, such as <n>, means don’t
update the counter value (use the value from the previous numbered paragraph).
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FrameMaker 4.0 includes two new symbols for controlling the counter: < > means
keep the counter value the same, but don’t display it, and < =0> means reset the
counter to zero but don’t display it. These symbols are useful as place holders in
complex formats using multiple counters, as will be demonstrated shortly.

The easiest format to create is a simple numbered list. The only format code this
requires is <n+>. ; this means use Arabic numerals followed by a period and a space
and increment the value with each new paragraph. We’ll call this format “List Item.”
This produces a result such as that in Figure 5.20. You could use Roman numerals or
alphabetic characters instead of Arabic numerals by substituting their codes for the n,
but the basic principle remains the same. Suppose, however, that you want to create a
second numbered list in the same document or chapter using the same format. If you
just tag the paragraphs in the second list with the List Item format, the second list will
pick up the numbering where the first list left off. You could create a different format
for the second list, and for each subsequent list in the document, but fortunately,
there is a more efficient approach. You need only create a new tag for the first item in
the list (we’ll call it, imaginatively, “First Item”) with the code <n=1>. . This format
resets the number to one. Apply this format to the first item in each subsequent list
and apply the List Item tag to all the remaining items in the list. You can create as
many simple lists in a document as you wish, using only these two formats.

Figure 5.20 A simple autonumbered list

1. Open both the document with the format you
want to copy (the source) and the document
in which you want to use the copied format
(the destination).

2. Click an insertion point in the source docu-
ment paragraph (paragraph format) or select
atextblock (character format) with the format
you want to copy.

3. Openthe Edit Menu and select Copy Special>
Character Format or Copy Special>Para-
graph Format, as appropriate.

4. If you are copying a paragraph format, click
an insertion point in the paragraph in the des-
tination document where you want to apply
the format; if you are copying a character for-
mat, highlight the block of text in the destina-
tion document to which you want to apply the
format.

5. Open the Edit menu and select Paste to apply
the format.
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You can use the Next  setting in the Basic Properties group to ensure
l that a First Item paragraph is always followed by a List Item paragraph.

SHORTCUT

Using Series Labels

The formats described above will work well for a series of non-overlapping lists,
such as the steps in a series of procedures to be performed in succession in a ser-
vice manual or instructional book. However, it will not work for numbered lists that
overlap. For this situation, you need to use a series label. A series label can be any
printing character followed by a colon. If it is included, the series label must be the
first item in the format. The purpose of the series label is to distinguish among dif-
ferent overlapping series in the same text flow. For example, you might want to
number figures, tables, and photographs in the same chapter or publication, with
the numbered items being freely interspersed in the layout, using formats such as
Figure <n+*>, Table <nt+>, and Photo <nt+>.If you don’t use series labels,
FrameMaker will simply update the counter once for each numbered item it finds,
producing a single continuous series of numbers for figures, tables, and photos
combined. However, if you use series labels, such as F:Figure <n+>, T:Table
<n+>, and P:Photo <n+>, FrameMaker will distinguish among the three formats
and maintain three separate numbered series.

A more complex task is to create the numbering formats for a standard outline.
The codes for the first four levels of a standard outline are shown in Table 5.2. An
outline must have formats for each level in the hierarchy, and the counters for each
level must be updated only when appropriate. This means that FrameMaker must
keep track of several different counters, updating the one that is currently dis-
played, while maintaining all the others. Here, the < > symbol is used to keep the
counters for the higher levels from being updated while the lower level is updated
and displayed. Hence, each level has one < > for each higher level. If the < > were
not included, FrameMaker would assume that all the formats belonged to a single
list, and the first three items would be I, B, and 3, rather than I, A, and 1.

Table 5.2 Numbering codes for a standard outline format

Code Function Example
<R+>. First level I
\t< D<A+, Second level A
\t\t< >< ><n+d>. Third level 1.

\t\t\t< >< >< X<atd>. Fourth level a.
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Placing the tab codes in a numeric format does not create the neces-
sary tab stops. They must be created using the Tab Stops option in the
Basic Properties group or the tab buttons on the Formatting Bar. You
could also use different left indents rather than tabs to align the differ-
N O T E entlevels of an outline.

A slightly different format is used for a legal or numeric outline, which attaches the
number from the higher hierarchical level to its subtopics (for example, 1.,1.1,,1.1.1,,
and so on.) The codes for this format are shown in Table 5.3. This format is also used
to number headings, figures, and tables in some technical publications. For additional
examples of numbering formats, examine FrameMaker’s outline templates.

Table 5.3 Formatting codes for a legal or numeric outline

Code Eunction Example
<n+> . <n=0> First level 1.0
<n>.<n+> Second level 1.1
<n>.<n>.<n+> Third level 1.1.1
<n>.<n>.<n>.<n+> Fourth level 1.1.1.1

Bulleted Lists

You can use an autonumbering format to create a bulleted list. You can also create
bulleted items by manually typing the bullet character and a tab, but using an auto-
numbering format offers the advantages of being able to quickly change the bullet
style or other aspects of the format, and to transform numbered lists or other for-
mats into bulleted lists and vice versa.

This simplest method for creating a bulleted list is to define a paragraph tag with a
numbering format that consists of just the bullet character code and the tab code
(\b\1t). To create a paragraph that “hangs” from the bullet, you must also use the
Basic Properties group to set a first line indent of zero and a positive left indent. Set
the first tab stop in the paragraph to the same position as the left indent. (Use this
same procedure for numbered lists that hang.) If you are going to mix bulleted lists
with body paragraphs that use a first-line indent, it is a good idea, design-wise, to
use the same figure for the left indent of bullet paragraphs and the first-line indent
of body paragraphs. In many cases, a one-em indent makes a good starting point. If
you’re using a side head format, (described earlier in this chapter) you can create
bullet lists with bullets that hang in the left margin by making the bullet list items
side heads with wide left indents.

If you don’t want to use the predefined bullet character, you can substitute any other
character that is available on your system. The Zapf Dingbats font offers many good
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choices, as do other decorative fonts. To use a character from one of these fonts as a
bullet, you must create a Character Format (described later in this chapter) with the
appropriate font and size. The format will appear in the Character Format list in the
Numbering Properties group. Type the character you want to use as part of the num-
bering format, then select the Character Format from the list box. The selected char-
acter format will appear in the text box above the list. For example to use the shaded
box character from the Zapf Dingbats font (Q), followed by a tab, type o\t in the
numbering format box, then select the Zapf Dingbats character format.

Advanced Properties

Don’t be put off by the name if you don’t consider yourself an “advanced” user—
this group of properties controls paragraph characteristics that are important to
the overall appearance and legibility of body type, namely hyphenation and word
spacing. It is essential to understand the effect of these characteristics and use them
correctly to obtain consistent, professional results.

Hyphenation

FrameMaker uses a combination of dictionary-based and rule-based hyphenation.
When it encounters a word that needs to be hyphenated, FrameMaker first looks
up the word in the spell-checker dictionaries. If the word is listed in one of the dic-
tionaries, FrameMaker uses one of the hyphenation points stored there. If the word
is not listed, FrameMaker applies a series of rules to select a hyphenation point. You
can also manually control hyphenation of selected words by inserting discretionary
hyphens and nonbreaking hyphens while you type (see Chapter 3), by suppressing
the hyphenation of selected words, or by altering the hyphenation points of words
in the spell-checker dictionaries (see Chapter 11).

In the Automatic Hyphenation area of the Advanced Properties dialog box (Figure
5.21), you can set the following hyphenation properties, in addition to turning
hyphenation on or off:

Figure 5.21 The Advanced Properties dialog box
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Max # Adjacent—selects the number of consecutive lines that can end in a hyphen.
Fewer hyphenated lines make body text easier to read, but may result in more loose
lines in justified text or a more ragged edge in left-, right, or center-aligned text.
The narrower the column for a given type size, the more consecutive hyphens will
be needed to avoid loose or ragged lines. For reasonably sized columns of body
type, a maximum of two consecutive hyphens is a good rule of thumb.

You may be used to a program, such as PageMaker or Ventura, that can
automatically flag loose lines. FrameMaker does not offer this feature,
‘ so you will have to keep an eye open for them. Look for lines that
stand out visually from the flow of body text because of excessive white

N 0 T E space between words.

Shortest Word—designates the shortest word length that can be hyphenated. The
higher the value, the fewer the words that may be hyphenated and hence the
greater the possibility of loose or ragged lines.

Shortest Prefix/Shortest Suffix—these two settings control the length of the short-
est syllable that can occur before and after a hyphen. As with the Shortest Word
option, increasing the value of either of these settings will tend to reduce the num-
ber of hyphens and increase the likelihood of loose lines or excessively ragged line
ends.

Language

This selection determines which dictionary FrameMaker uses to look up hyphen-
ation points. If you create documents that mix different languages and have the
appropriate foreign language dictionaries installed, you can select the appropriate
language to use in hyphenating any given paragraph. The Language setting is also
used by the spelling-checker for selecting the appropriate dictionaries when check-
ing multilingual documents.

Word Spacing

Word spacing, not surprisingly, is the space between consecutive words (here
FrameMaker has retained the conventional term). There are three settings here
which, in conjunction with the letter spacing (Spread) and hyphenation settings,
have a considerable effect on the spacing and overall appearance of paragraphs,
especially body text. The three settings—Minimum, Maximum, and Optimum—are
expressed as percentages of the standard spacing for the default font, which also
appears in the dialog box. The latter figure is a feature of the font and cannot be
easily altered by the user.

FrameMaker uses the Minimum, Maximum, and Optimum values in adjusting the
spaces between words in each line. The greater the range of values you give it, the
more flexibility it will have. How this is manifest depends on the type of alignment
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you have selected for the paragraph. In left-, right-, and center-aligned paragraphs,
a wider range results in less ragged line ends, whereas in justified paragraphs a
wider range results in tighter spacing and fewer loose lines (see Figure 5.22). An
additional setting, Allow Automatic Letter Spacing, affects only justified para-
graphs. When on, this setting allows FrameMaker to adjust the spacing between
characters in order to keep the spaces between words within the limits specified by
the Minimum and Maximum settings.

Figure 5.22 A paragraph set with several different word spacings

Justified—50/100/150

The right of the people to be secure in their
persons, houses, .papers, and effects,
against unreasonable searches and sei-
zures, shall not be violated, and no War-
rants shall issue, but upon probable cause,
supported by oath or affirmation, and par-
ticularly describing the placeto be searched
and the persons or objects to be siezed.

Justified—100/100/100

The right of the people to be secure in
their persons, houses, papers, and
effects, against unreasonable searches
and seizures, shall not be violated, and
no Warrants shall issue, but upon proba-
ble cause, supported by oath or affirma-
tion, and particularly describing the place
to be searched and the persons or
objects to be siezed.

Left Aligned—50/100/150

The right of the people to be secure in their
persons, houses, papers, and effects,
against unreasonable searches and sei-
zures, shall not be violated, and no War-
rants shall issue, but upon probable cause,
supported by oath or affirmation, and par-
ticularly describing the place to be
searched and the persons or objects to be
siezed.

Left Aligned—100/100/100

The right of the people to be secure in
their persons, houses, papers, and ef-
fects, against unreasonable searches and
seizures, shall not be violated, and no
Warrants shall issue, but upon probable
cause, supported by oath or affirmation,
and particularly describing the place to
be searched and the persons or objects
to be siezed.

Frame Above Y/Below 1

This option is used to attach reference frames to selected paragraphs. Reference
frames contain frequently used graphic or textual elements, such as rules, icons,
ornaments, or special headings, that are stored on reference pages. The available
reference frames for the document can be selected from pop-up menus and
attached either above or below the selected paragraphs. For information on creat-
ing reference frames, see Chapter 4.
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Table Cell Properties

The final group in the Paragraph Designer, Table Cell Properties, applies only to
tables, and will therefore be reserved for Chapter 20.

Character Formats

Character formats behave similarly to paragraph formats, except that they are
applied to individual characters, words, or phrases, rather than to entire paragraphs.
The most obvious uses of character formats are to emphasize selected words with
type variations such as boldface or italics and to apply attributes such as superscript,
subscript, or underline. You can also use a character format to apply a special font
such as Symbol, Zapf Dingbats, or a decorative or technical Pi font.

The Character Designer

The Character Designer (Figure 5.23) has also been renamed and redesigned in
FrameMaker 4.0. It is much simpler than the Paragraph Designer, consisting of
only one group. In fact, the Character Designer is identical to the Default Font
group in the Paragraph Designer, and all of the options perform in exactly the
same manner as described above, so we won’t duplicate that information here. Sim-
ilarly, the Apply and Update All buttons and the Command menu work the same
way as those in the Paragraph Designer.

Figure 5.23 The Character Designer
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Creating Flexible Character Formats

If you want a character format to change only one or two aspects of the text that it
is applied to (as is usually the case), set the Character Designer to As Is using the
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option on the Command menu, then set only the characteristics you want the for-
mat to change. This way, you won’t have to revise your character formats whenever
you change some property of the paragraphs they reside in. It will also allow you to
use your character formats on a variety of different types of paragraphs, rather than
having to create lots of different formats for use in special cases.

Suppose, for example, that your body text font is 11-point Times Roman. If you
wanted to use boldface for emphasis, it would seem logical to define the Emphasis
character format as 11-point Times bold. This would be okay, provided you intend
to use the format only in body paragraphs and you never decide to change the fam-
ily or size of your body type. But suppose you decide later to change your body type
to 12-point Adobe Garamond. When you apply the new paragraph format to your
body paragraphs, you will be asked whether to remove or retain overrides. Since
you don’t want to lose your emphasized characters and other character formats,
you choose to retain your overrides. The result is that you now have body text in 12-
point Adobe Garamond regular, with emphases in 11-point Times bold. Not what
you want. Now you have to go back and redefine your Emphasis format as 12-point
Adobe Garamond bold (you can’t change it to As Is at this point, because that
would just cause it to remain 11-point Times). And you will have to re-edit the for-
mat (and any others you defined along the same lines) every time you change the
Body paragraph format.

If you use the As Is setting when you first create the Emphasis format, then all the
other characteristics of the emphasized characters will change appropriately when
you change the Body paragraph format. This works even when the font family uses
a different name for boldface, though, of course, it will not work if you don’t have a
boldface version of the font installed on your system. Use the same technique for
any other character format you use to apply a single variation, such as subscript,
superscript, italic, small caps, or the like, and you’ll spend far less time fooling with
character formats. This not only allows you to change paragraphs that have charac-
ter format overrides and have the formatted characters change appropriately, it
also allows you to use the same character formats in paragraphs with different type-
faces or sizes.

Using a character format to select a non-text font, such as Symbol or
Zapf Dingbats, is a bit tricky if the characters to which you are applying
‘ the format have ANSI codes higher than 0126 (see Appendix 1 for a
complete listing of characters and their ANSI codes). If you type the
N 0 T E character(s) first and then apply the format, the wrong characters will
appear and frustration will likely ensue. To get the right characters,
you must apply the character format at the insertion point first, and
then type the ANSI codes.
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If you select all the text in a paragraph, including the paragraph mark (%)

at the end and apply a character format, you will change the Default

‘ Font properties of the paragraph format to match those of the of the

character format. To change the character format of an entire para-

N 0 T E graph without changing the paragraph format, select all the characters
in the paragraph except the paragraph mark.

Using Formats from Other Documents

In addition to using the formats that you have created in a particular document or
inherited from one of FrameMaker’s templates, you can borrow a few formats or
even a whole catalog from another FrameMaker document. This applies equally to
Paragraph Formats and Character Formats.

If you want to use only a few formats from another document, the easiest approach
is to copy the format from one document and paste it in the other:

1. Open both the document with the format you want to copy (the source) and
the document in which you want to use the copied format (the destination).

2. Click an insertion point in the source document paragraph (paragraph format)
or select a text block (character format) with the format you want to copy.

3. Open the Edit Menu and select Copy Special>Character Format or Copy
Special>Paragraph Format, as appropriate.

4. If you are copying a paragraph format, click an insertion point in the para-
graph in the destination document where you want to apply the format; if
you are copying a character format, highlight the block of text in the desti-
nation document to which you want to apply the format.

5. Open the Edit menu and select Paste to apply the format.

Copying a single paragraph or character format into a document
doesn’t automatically add that format to the catalog in the destination
‘ document. If you want to add the new format to the catalog, you must
open the Paragraph Designer or Character Designer, as appropriate,

N 0 T E and follow the procedure described earlier in this chapter for storing a
new format in the catalog.

You can also import all the Paragraph and/or Character formats from another doc-
ument or template, along with many other characteristics:
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1. Select the Import>Formats option from the File menu.

2. A dialog box like that in Figure 5.24 will appear. Check the aspects of the
document you want to import, that is, paragraph formats and/or character
formats. Be sure to check only the appropriate characteristics; otherwise, you
might drastically revise every aspect of your document in one fell swoop.

Figure 5.24 The Import Formats dialog box
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3. Open the list box that says “Current,” meaning the document that’s cur-
rently active, and select the document from which to import the formats
(you can only select a document that’s currently open).

4. Click the Import button to import the selected formats from the source doc-
ument into the catalog(s) of the destination document, where they will be
added to the existing formats.

The formats from the source catalog will replace formats in the desti-
nation catalog with the same name. If you’re not careful, this might
‘ cause unforeseen results where formats of the same name exist in both
catalogs. Since the operation of importing the formats is not undo-
N 0 T E able, it’s a good idea to save your document immediately before per-
forming this operation, so you can revert to the saved version if

something goes awry.

Formatting Characters on the Fly

In addition to creating and applying character and paragraph formats, Frame-
Maker allows you to perform limited text formatting using three commands on the
Format menu: Font, Size, and Style. The Style option duplicates several of the

RS
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choices found in the Character Designer and the Default Font Properties group in
the Paragraph Designer: Plain, Bold, Italic, Underline, Double Underline,
Strikethrough, Overline, Change Bar, Superscript, and Subscript. To use these com-
mands, a block of text must be highlighted.

Six of the buttons in the Text Editing group on the Quick Access Bar affect text for-
matting:

k| Plain text (the default font for the paragraph)

Bold text

Underlined text

Italic text

Increase type size by one point

Decrease type size by one point

You can also set paragraph alignment, tab stops, and line spacing with the buttons
on the Formatting Bar.

Use these formatting methods for occasional, one-of-a-kind format changes. In
most cases, it is preferable to use paragraph and character formats, as they ensure
consistency throughout a document or family of documents and make it easy to
change all occurrences of a particular format.






